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RESUMEN

Las zonas Optimas para un relleno sanitario son muy escasas debido al
cumplimiento de los parametros establecidos por las normativas vigentes, es por ello, que
se planted como objetivo determinar zonas Optimas para un relleno sanitario en el distrito
de Santa Ana — Cusco utilizando sistemas de informacion geografica. La presente
investigacion mostrd un enfoque cuantitativo, de disefio descriptivo no experimental y de
corte transversal, una técnica de observacion indirecta, cuyos instrumentos fueron los
geoportales de organismos publicos nacionales e internacionales, empleandose para el
procesamiento de la informacion el software Arcmap 10.3. Los resultados obtenidos

encontrados fueron que la zona potencial tuvo una extension de 79 ha.

PALABRAS CLAVES: zonas 6ptimas, relleno sanitario y orientaciéon geografica
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CAPITULO I: INTRODUCCION

1.1. Realidad problematica

En el afio 2016, la produccion mundial de desechos solidos se estim6 en 2 017
millones de toneladas anuales, con un 33 % de residuos vertidos de manera abierta. En el
mismo periodo, en Latinoamérica y el Caribe, se calculd una produccion de 231 millones
de toneladas anuales de desechos solidos, de los cuales el 17 % fue vertido abiertamente
(Kaza et al., 2018). Hace 13 afios, en nuestro pais, se generaron casi 8 millones de
toneladas de desechos solidos, con un 44.35 % de residuos vertidos de forma abierta
(MINAM, 2021).

La disposicion final adecuada de estos desechos depende principalmente del tipo
de residuo producido. Sin embargo, la tecnologia de relleno sanitario (RS) estd mas
extendida en América Latina (Cobos et al., 2021). Los RS son la opcion més ventajosa y
menos costosa para el tratamiento de desechos solidos en zonas urbanas (Villafuerte et
al., 2004, citado por Altamirano, 2019). Ademas, son ideales tanto para ciudades con poca
como mucha poblacién, asi como para areas rurales (Vallero y Blight, 2019, citado por
Altamirano, 2019). Su correcto funcionamiento dependera de la ubicacion y los
estandares de construccion (Caballero-Saldivar et al., 2011; Vallero y Blight, 2019, citado
por Altamirano, 2019).

La ubicacion de los RS se considera un tema crucial en los sistemas de gestion
urbana, ya que debe tener en cuenta aspectos econdmicos, politicos y medioambientales
(De Waele et al., 2004 y Sener et al., 2011, citados por Altamirano, 2019).

En este contexto, algunas provincias y distritos a nivel nacional se ven afectados
por la seleccion inadecuada de areas para rellenos sanitarios, especialmente en términos

ambientales. Incluso, en casos como el distrito de Santa Ana, la falta de ubicacién de

Paz Atauchi, G. Pag. 12
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zonas Optimas para relleno sanitario puede deberse a la complejidad de aplicar
metodologias y herramientas geoespaciales. Esto puede resultar en sanciones
administrativas de hasta 1 400 UIT por incumplimiento de la gestion adecuada de
desechos sdlidos, que afectan la salud de la poblacion, la contaminacion de acuiferos, la
proliferacion de bacterias y plagas, y los contaminantes responsables del aumento de la
temperatura del planeta.

Por lo tanto, este estudio es significativo, ya que ayudara a identificar las mejores

ubicaciones para RS en el distrito de Santa Ana.

1.2. Formulacion del problema

1.2.1. General

(Cual seran las zonas Optimas para RS en el distrito de Santa Ana - Cusco,
utilizando sistemas de informacion geografica, 2023?
1.2.2. Especifico
1. ;Qué zonas del espacio geografico del distrito de Santa Ana son potenciales
para RS?
2. (Cual sera la prelacion segun grado de idoneidad de las zonas potenciales para
RS en el espacio geografico del distrito de Santa Ana?
3. (Cuadl serd la informacion geografica en campo de las zonas Optimas para

relleno en campo?

Paz Atauchi, G. Pag. 13
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1.3. Objetivos

1.3.1. General

Determinar zonas 6ptimas para RS en el distrito de Santa Ana — Cusco utilizando
sistemas de informacion geografica, 2023.

1.3.2. Especificos

2. Determinar las zonas del espacio geografico del distrito de Santa Ana que son
potenciales para RS.

3. Evaluar la prelacion segun grado de idoneidad de las zonas potenciales para

RS en el espacio geografico del distrito de Santa Ana.
4. Identificar la informacidon geografica en campo de las zonas Optimas para
relleno en campo.
1.4. Hipétesis

Por ser investigacion de alcance descriptivo, carece de hipdtesis.

Las investigaciones descriptivas que formulan hipotesis son solamente las que
buscan realizar pronodsticos de cifras, hechos o datos (Herndndez-Sampieri y Mendoza,
2018).

1.5. Justificacion

1.5.1. Teorica

La finalidad de este estudio es la ubicacion de zonas Optimas ambientalmente y
con mayor rentabilidad para una propuesta de obra y funcionamiento de un RS en el
distrito de Santa Ana, de acuerdo al contexto del desarrollo sostenible, bajo sus tres
dimensiones, Tyler (1992) citado por Javier (2015):

Sostenibilidad ambiental: Reduccion de las emisiones deletéreas para conservar

el medio ambiente y su biodiversidad.

Paz Atauchi, G. Pag. 14



UNIVERSIOAD Santa Ana - Cusco, utilizando sistemas de informacion

PRIVADA

1 upN Determinacion de las zonas optimas para relleno sanitaric en el distrito de
DEL NORTE geografica, 2023
Eficiencia econémica: Aquella que ofrece equilibrio entre la productividad, la
generacion de trabajo e inversiones.
Equidad social: Aquella que genera equidad demogréfica entre los seres humanos

y sus respectivos estandares laborales.

1.5.2. Practica

Este estudio puede servir como punto de partida para futuras investigaciones
relacionadas con este campo de trabajo. Es importante destacar que en el distrito de Santa
Ana no existen datos ni informes disponibles sobre el tema de estudio, a pesar de la
creciente necesidad de la poblacion de mejorar sus condiciones de vida actuales (Tyler,
1992 citado por Javier, 2015).

1.5.3. Metodologica

El analisis multicriterio con superposicion booleana en SIG entre otros algoritmos
de decision, son metodologias potenciales que tienen multiples aplicaciones, como es la
ubicacion de zonas Optimas para relleno sanitario; proporcionando resultados que
cumplen con los estandares cientificos necesarios (Tyler, 1992 citado por Javier, 2015).
1.6. Antecedentes

1.6.1. Internacionales

Sierra (2021) llevé a cabo un estudio titulado "Localizacion de areas probables
para la construccion de un relleno sanitario para Bucaramanga". El objetivo del estudio
fue identificar areas adecuadas para la ubicacion de un relleno sanitario destinado al
tratamiento de los desechos producidos en el Area Metropolitana de Bucaramanga. La
muestra consistio en el ambito geografico de varias municipalidades en Colombia. El
disefio utilizado fue no experimental y transversal. La metodologia empleada involucro

el analisis multicriterio utilizando una combinaciéon lineal ponderada de variables
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espaciales estandarizadas en una escala del 1 al 5, donde 1 representaba inadecuado y 5
representaba altamente adecuado. Se utilizo el software ArcGIS. Los resultados del
estudio indicaron que el 98.388% del area de estudio no era apto, el 0.015% era muy poco
apto, el 1.076% era moderadamente apto y el 0.521% era apto. El estudio también sefiald
que no se identificaron areas con una puntuacion de 5. Esta falta de areas con esa
clasificacion posiblemente se deba a condiciones particulares o caracteristicas especificas
del area de estudio. Como resultado, se identificaron seis zonas aptas (ZA): ZA 1
(38.4574 ha), ZA 2 (39.4426 ha), ZA 3 (41.8991 ha), ZA 4 (51.0266 ha), ZA 5
(52.1537 ha) y ZA_6 (52.8589 ha).

Gordillo (2019) llevo a cabo un estudio titulado "Localizacion de un Relleno
Sanitario en el cantéon Naranjal", mediante un proceso analitico basado en sistemas
geograficos. El proposito de esta investigacion fue identificar las posibles ubicaciones
para la construccion de un Relleno Sanitario en la mencionada area, utilizando un enfoque
de analisis geografico. La muestra comprendio el &mbito geografico del canton Naranjal
en Ecuador, utilizando un disefio no experimental transversal descriptivo. La metodologia
aplicada consisti6 en un analisis multicriterio con una combinacion lineal ponderada de
variables espaciales, donde se asignaron valores de 1 a 5 segtin la idoneidad de las zonas:
1 para zonas no idoneas, 2 para zonas con baja idoneidad, 3 para zonas con moderada
idoneidad, 4 para zonas con razonable idoneidad y 5 para zonas con O6ptima idoneidad.
Este analisis se realizdo mediante el software ArcGIS y fue posteriormente verificado en
el terreno. Los resultados obtenidos revelaron la existencia de ocho zonas optimas (ZO)
para la construccion del Relleno Sanitario, con sus respectivas extensiones de tierra:
Z0 _1(56.48 ha), ZO_2 (464.26 ha), ZO_3 (172.28 ha), ZO 4 (108.97 ha), ZO 5 (241.65

ha), ZO 6 (491.56 ha), ZO 7 (774.35 ha) y ZO_8 (1,030.65 ha).
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1.6.2. Nacionales

Bustamante (2022) llevo a cabo un estudio titulado "Identificacién de Areas
Optimas para la Planta de Tratamiento y Manejo Final de Residuos Solidos en el Distrito
de Chota, Utilizando Sistemas de Informacién Geografica (SIG)". El objetivo principal
de esta investigacion fue identificar, a través del empleo de SIG, zonas potenciales
adecuadas para la construccion de una estacion de procesamiento de residuos s6lidos en
el mencionado distrito. El ambito de estudio abarco6 la jurisdiccion de Chota, empleando
un disefio no experimental y transversal. La metodologia aplicada consistio en un analisis
multicriterio con superposicion booleana de variables espaciales codificadas en binario:
0 para no 6ptimo y 1 para 6ptimo. Este andlisis se llevo a cabo mediante el software
ArcGIS y fue validado en el terreno. Los resultados obtenidos indican la existencia de
areas potenciales que suman 536.86 ha, representando el 2.01% en relacion con el area
total de 26,645.28 ha. Estas areas se distribuyen en ocho zonas potenciales (AP): AP 1
(9.79 ha), AP_2 (80.64 ha), AP_3 (51.21 ha), AP_4 (161.95 ha), AP_5 (6.04 ha), AP_6
(34.22 ha), AP_7 (172.32 ha) y AP_8 (20.69 ha), todas ellas ubicadas con coordenadas
proyectadas WGS 1984 UTM Zone 178.

Loyaga (2019) llev6 a cabo un estudio titulado "Identificacion de Areas Optimas
para la Construccion de un Relleno Sanitario Utilizando Sistemas de Informacion
Geografica en Jaén". El objetivo general de la investigacion fue identificar zonas
apropiadas para la construccion de un Relleno Sanitario mediante el uso de SIG. La
muestra se centrd en el ambito geografico del distrito Las Pirias, y el disefio utilizado fue
de caracter no experimental, transversal y descriptivo. La metodologia empleada consistio
en un analisis multicriterio con combinacion lineal directa de variables espaciales

estandarizadas en una escala que iba desde cero (no apto) hasta 2 (apto), utilizando el
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software ArcGIS. Estas variables fueron posteriormente verificadas en el terreno. Los
resultados obtenidos identificaron dos zonas 6ptimas (ZO): ZO_A(2.63ha)y ZO B (3.17
ha), asi como trece zonas aceptables para Rellenos Sanitarios (ZA): ZA C (3.86 ha),
ZA D (4.67 ha), ZA_E (8.69 ha), ZA F (11.87 ha), ZA G (14.64 ha), ZA_H (17.37 ha),
ZA 1 (18.28 ha), ZA J (20.96 ha), ZA K (27.74 ha), ZA L (32.46 ha), ZA_ M (35.89
ha), ZA N (51.2 ha) y ZA N (59.82 ha).

Pérez (2019) llevo a cabo un estudio titulado "Identificacion de Zonas Optimas
para la Construcciéon de un Relleno Sanitario Utilizando Sistemas de Informacion
Geografica en el Distrito de Santa Rosa". El propdsito principal fue identificar, a través
del uso de SIG, las areas potenciales adecuadas para establecer un Relleno Sanitario en
el mencionado distrito. La muestra se conformo6 por el ambito geografico del distrito de
Santa Rosa, utilizando un disefio no experimental. La metodologia empleada consistié en
un andlisis multicriterio con superposicion booleana de variables espaciales codificadas
en binario, donde 0 representaba la imposibilidad de construccion y 1 indicaba que si era
posible construir. Este andlisis se llevd a cabo utilizando el software ArcGIS y fue
validado en el terreno. Los resultados obtenidos mostraron areas potenciales que suman
191.62 ha, lo que equivale al 0.71% respecto al area total de 26,840 ha. Estas areas se
distribuyen en siete zonas potenciales (AP): AP 1 (19.77 ha), AP_2 (30.90 ha), AP 3
(12.59 ha), AP 4 (17.13 ha), AP_5 (81.50 ha), AP_6 (7.17 ha) y AP_7 (22.56 ha), todas
ubicadas con coordenadas proyectadas WGS 1984 UTM Zone 178.

Altamirano (2019) llevé a cabo el estudio "Identificacion de Areas para el
Tratamiento de Residuos Solidos mediante Andlisis Espacial en el Distrito Chirinos-San
Ignacio". La meta de la investigacion fue establecer zonas potenciales y un lugar

adecuado para la disposicion de residuos solidos en San Ignacio, a través de la aplicacion
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del andlisis espacial. La muestra abarco el ambito geografico del distrito en cuestion,
utilizando un disefio no experimental y transversal. La metodologia aplicada consistio en
un analisis multicriterio que incorpord superposicion booleana y combinacion lineal
directa de variables espaciales codificadas en binario (donde 0 representaba no dptimo y
1 6ptimo) y estandarizadas en escalas de 1 para 6ptimo, 2 para aceptable y 3 para regular.
Este andlisis se llevd a cabo utilizando el software ArcGIS. Los resultados obtenidos
identificaron areas potenciales que suman 34.71 ha, equivalente al 0.1% del area total de
35,291 ha. Estas areas se distribuyen en seis zonas potenciales (AP): AP _1 (0.81 ha),
AP 2(2.92 ha), AP _3(0.84 ha), AP_4 (1.75 ha), AP_5(18.93 ha) y AP_6 (9.46 ha), todas
localizadas con coordenadas proyectadas WGS 1984 UTM Zone 178.

1.6.3. Regional

Uscamayta (2021) llevo a cabo un estudio titulado "Determinacion de Areas
Optimas para la Instalacién de Rellenos Sanitarios mediante Sistemas de Informacion
Geografica (SIG), Apoyado en la Técnica de Evaluacion Multicriterio en la Provincia del
Cusco". El proposito principal de la investigacion fue identificar las areas idoneas para la
construccion de Rellenos Sanitarios en Cusco, empleando SIG respaldados por la técnica
de evaluacion multicriterio. La muestra se conformé por el ambito geografico de la
provincia del Cusco, utilizando un disefio no experimental y transversal. La metodologia
empleada consistio en un analisis multicriterio con combinacion lineal directa de
variables espaciales estandarizadas en escalas de 1 para bajo, 2 para medio y 3 para alto,
utilizando el software ArcGIS. Estas variables fueron luego verificadas en el campo. Los
resultados obtenidos revelaron la existencia de tres dreas con potencial medio para la
provincia de Cusco. Estas zonas con potencial medio (ZPM) se distribuyen de la siguiente

manera: ZPM_1 (72 ha), ZPM 2 (215 ha) y ZPM_3 (65 ha).
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1.7. Marco tedrico
Para entender el contenido de este trabajo se defini6 algunos términos relevantes,

para ellos se acopio conceptos de varios autores e instituciones. A continuacion, se detalla:

1.7.1. Relleno sanitario (RS)

Se trata de un método de ingenieria utilizada con la finalidad de aislar los RS en
municipalidades. Involucran la capacidad de esparcir, disponer y compactar los RS en un
lugar no permeable, con la consecuente cubierta diaria con material inorganico. Este
proceso tiene como objetivo controlar la proliferacion de vectores, gestionar
adecuadamente los gases y lixiviados, y prevenir la contaminacion ambiental, todo esto
en beneficio de la salud publica. Un relleno sanitario se caracteriza por contar con un plan
de ingenieria, un control de acceso en la entrada, pesado y la ausencia de segregadores en
el lugar (MINAM, 2019). Los RS son una pieza fundamental en la gestion de desechos
solidos urbanos, ya que proporcionan un método seguro y efectivo para la disposicion
final de desechos. Su utilidad radica en que ofrecen un medio controlado y
ambientalmente seguro para la eliminacion de residuos, minimizando el impacto negativo
en el entorno. Estos sitios estan disefiados con sistemas de impermeabilizacion, control
de lixiviados y biogés, lo que contribuye a prevenir la contaminacion del suelo y las aguas
subterraneas, asi como a reducir la emision de contaminantes generadores de efecto
invernadero. Ademads, los rellenos sanitarios permiten la recuperacion de terrenos
previamente degradados, lo que promueve la restauracion ambiental y, a largo plazo, la

reutilizacion de dreas para fines mas sostenibles. Asimismo, es importante lo siguiente:
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La forma de construccion que se disefiara se evalua tomando en cuenta la cantidad

de RS que se producen diariamente, como se detalla a continuacion:

Tabla 1

Clasificacion de los RS

Criterio Manual Semimecanizado Mecanizado
Capacidad de
disposicion de Hasta 6 t/dia Superior a 6 hasta 50 Mas de 50 t/dia

residuos solidos
municipales

Caracteristicas
de la operacion

Periodicidad del
uso de
magquinaria

Las actividades
de disposicion
final de residuos
se realizan en
forma manual y
con empleo de
herramientas
manuales.

Esporadica,
cuando se
necesita por
ejemplo para
acopio de tierra
para cobertura

t/dia

Las actividades de
disposicion final de
residuos se realizan
necesariamente con

equipo multiusos (Por

ejemplo: Minicargador o

Retroexcavadora)
asignado para
utilizacion exclusiva del
relleno sanitario.

Frecuente, segtn la

cantidad de residuos que
se disponga diariamente,

disponibilidad de tierra
para cobertura y
condiciones climaticas

Las actividades de
disposicion final de
residuos se realizan
necesariamente con
maquinaria pesada,

la que debe estar

asignada para uso
exclusivo del relleno

sanitario.

Permanente.

Nota. Adaptado de la Guia para el disefio y construccion de infraestructuras para
disposicion final de residuos sélidos municipales (MINAM, 2019).

1.7.1.2. Método de disposicion final
MINAM (2019) establecio tres métodos de disposicion final: trinchera, area y
combinado; determinadas principalmente por el relieve del terreno y las caracteristicas

geograficas del suelo, para lo que se debe considerar los estudios de topografia del lugar
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y caracteristicas geotécnicas. A continuacion, se ilustran los métodos de disposicion final

a fin de entender mejor:

Figura 1

Meétodo de disposicion final: a) trinchera y b) area

Nota. Adaptado de la guia destinada a construir edificaciones para disponer desechos
solidos (MINAM, 2019).
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Figura 2

Meétodo de disposicion final: combinado

Cubierta
final

Nivel de

% i’ %‘% suelo original

h*;‘ *‘*\ﬁ '! \

Material
de cobertura

Residuos
solidos

Excavacion

Nota. Adaptado de la guia destinada a construir edificaciones para disponer desechos
s6lidos (MINAM, 2019).

1.7.1.3. Extension del terreno y vida util

MINAM (2019) establece que la superficie requerida para una vida tutil mayor a
una década se estima con la cantidad méaxima diaria de residuos para casos de relleno
sanitario manual y semimecanizado, como se detalla a continuacion:
Tabla 2

Superficies de terreno referenciales para relleno sanitario

Relleno Relleno sanitario Relleno sanitario
sanitario manual semimecanizado mecanizado

Hasta 6 t/dia De 6 hasta 50 t/dia Mas de 50 t/dia
BUPEINGIE deTEReng fur 0,75 ha 3,30 ha 10,00ha
vida util de 10 anos
Vias; campamento, areas 4,00 ha 5,25 ha 10,00 ha
libres, infraestructura diversa
S b 5,00 ha 10,00 ha 23,00 ha

recomendable:

Nota. Adaptado de la guia destinada a construir edificaciones para disponer desechos
solidos (MINAM, 2019).
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1.7.1.4. Seleccion de area para construccion de RS

Es el proceso que identifica superficies acotadas para relleno sanitario en espacios
geograficos jurisdiccionales, teniendo en cuenta condiciones de cardcter restrictivo y
limitante. Sin embargo, para entender esta investigacion, se precisa las siguientes
definiciones:
1.7.1.4.1. Zonas potenciales

Superficie acotada que tiene la posibilidad de ser lugares considerados idéneos
para relleno sanitario, tomando en consideracion caracteristicas fisicas, bioldgicas,
sociales, econdmicas y culturales; clasificado en criterios de restricciones y exclusiones
(MINAM, 2021).
1.7.1.4.2. Zonas dptimas

Superficie acotada considerados propicios y mds conveniente ambientalmente y
con mayor rentabilidad para una propuesta de obra de RS, tomando en consideracion
algunas estipulaciones establecidas (Javier, 2015 y Arias, 2021).

1.7.2. Sistemas de informacion geogrifica (SI1G)

La definicion precisa hace referencia a una forma de integrar formas informaticas,
poblacionales y geograficas para ejecutar la captura, analisis, almacenamiento, edicion y
representacion de informacion de referencia geografica. Los SIG ayudan a identificar
patrones espaciales, evaluar el impacto ambiental, planificar el uso del suelo, gestionar
recursos naturales y responder a problemas ambientales de manera mas eficiente,
contribuyendo asi a un enfoque mas sostenible en la ingenieria ambiental (Korte, 2001

citado por Olaya, 2020).
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1.7.2.1. Subsistemas del SIG

Para Olaya (2020) se requiere la mencion de los siguientes subsistemas:

De gestion de datos. El cual es encargado de ejecutar actividades relacionadas al
flujo de datos, desempena un papel fundamental en la infraestructura del sistema. Su
funcion principal es permitir que los demas subsistemas puedan acceder a la informacion
y funcionen en base a la informacion disponible.

De visualizacion. Genera una representacion basada en informacién similar a un
mapa, leyenda u otras visualizaciones, ademas permite a los usuarios no solo visualizar
los datos, sino también modificarlos o crear nuevas representaciones.

De analisis. Que alberga los procedimientos necesarios para analizar la
informacion geografica que se va generando a partir del uso y aplicacion de los demas
subsistemas.

1.7.2.2. Los datos de un SIG

En el marco de los SIG nos aparece con frecuencia dos términos datos e
informacion geografica, que usualmente lo confundimos. Para Olaya (2020) se tiene una
gran diferenciacion entre las definiciones:
1.7.2.2.1. Datos geogrificos

Los datos son un componente fundamental en un SIG. Se pueden conceptualizar
como un gran conjunto de valores o elementos que representan informacion especifica
acerca de la geografia de un lugar.
1.7.2.2.2. Informacion geogrifica

Resulta del procesamiento de datos e interpretaciones como el producto del
tratamiento de los mismos y con el principal enfoque de hacer de esta informacion lo mas

util en términos de lo accesible.
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1.7.2.3. Componentes de la informacion geografica

Para Olaya (2020) estos componentes son dos:
1.7.2.3.1. Espacial

Hace referencia a la ubicacion en el marco de un sistema referenciado de
establecimiento previo, de caracter fundamentalmente numérica.
1.7.2.3.2. Temadtica

Corresponde a la naturaleza y los componentes de la categoria espacial, que son
de caracter fundamentalmente numérica y alfanumérica.

Alternativamente a los componentes previamente mencionados, Sinton (1978)
citado por Olaya (2020) amplia la definicién al incluir un tercer componente que
determina como temporal, asi mismo, propuso un sistema cuya finalidad es permitir la
clasificacion en conjuntos de diferentes tipos de datos geograficos. De acuerdo a dicho
sistema, cada componente puede encontrarse enmarcado dentro de 3 posibles estados:
fijos, controlados o medidos.

1.7.2.4. Dimensiones de la informacion geografica

Cada elemento registrado puede encontrarse en un plano sencillo (0D) o llegar
hasta un volumen tridimensional (3D), como se muestra a continuacion:
Figura 3

Dimensiones de los datos geograficos

¢ L. A =

Punto (0D} Linea(1D) Poligono(2D) Relieve(2.5D) Poliedro(3D)

Nota. Sistemas de Informacién Geografica de Olaya (2020).
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1.7.2.5. Unidades de la informacion geografica

Cada unidad incorporada a un SIG es denominada como “capa”, tal como se
muestra en la Figura 4. La operacion mediante capas ejerce una administracion de datos
geograficos de forma transparente en un SIG, lo cual significa la mejora en cuanto a
integrar la diferente informacion proporcionada, asi mismo se considera como el
mecanismo primordial de diferentes tratados en la division transversal y de orientacion
vertical de datos geograficos.

Figura 4

Unidad de medida en un SIG: capa

Elevacion
Uso de suelo
Suelo

Hidrografia

Nota. Sistemas de Informacion Geografica de Olaya (2020).
1.7.2.6. Modelos de representacion de informacion geografica

Para definir los modelos mas importantes utilizados en unidades de datos
geograficos se emplean los términos de unidad o capa de vector y capa raster, que a

continuacion se detalla:
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1.7.2.6.1. Modelo raster

En este modelo, el 4rea de investigacion se centra sistematicamente en un conjunto
de unidades mas pequefias (a menudo llamadas celdas), y para cada unidad se recopila
informacion relevante que la describe. La resolucion y la precision son directamente
proporcionales: cuanto menor sea la resolucidn, mayor serd la precision de la
informacion. Una de las propiedades mas destacadas de la informacion en raster es la
capacidad de realizar analisis graficos y estadisticos.
1.7.2.6.2. Modelo vectorial

En este modelo, no se dividen las 4reas capturadas en unidades fundamentales. En
cambio, se captura la variabilidad y las caracteristicas de estas 4reas a través de entidades
geométricas. Este enfoque modela la geografia utilizando primitivas geométricas, las
mismas que representan las unidades notables del mencionado lugar.

Este modelo, en el contexto de la representacion de informacién geografica, es
una metodologia que se basa en la utilizacién de objetos geométricos precisos, como
puntos, lineas y poligonos, para describir y representar de manera detallada caracteristicas
geograficas en la Tierra. Cada entidad vectorial, como un punto que denota una estacion
meteorologica o un poligono que delimita una zona de proteccion ambiental, estd definida
por coordenadas geoespaciales que permiten su localizacion exacta en el mundo real. Este
modelo es invaluable en la ingenieria ambiental, ya que posibilita el andlisis espacial, la
planificacion del uso del suelo, la gestion de recursos naturales y la toma de decisiones
ambientales informadas, al permitir la representacion precisa y la manipulacioén de datos

geograficos complejos en sistemas de informacion geografica (SIG).
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Figura 5

Esquemas del modelo de representacion vectorial (a) y raster (b) y (c)

- aa e gt

Nota. Sistemas de Informacién Geografica de Olaya (2020).
1.7.2.7. Fuentes de datos espaciales

La informacion con la que se trabaja en el SIG puede tener diferentes sitios de
procedencia; pero basicamente trabajamos con fuentes de datos primarias y secundarias.
1.7.2.8. Fuentes primarias

Son aquellos que se obtienen directamente a través de algin tipo de medicion o el uso de
instrumentacion especifica, como la teledeteccion, GPS, entre otros. Estos datos pueden ser

utilizados en un SIG en la manera primaria y se consideran aptos para someterse a actividades de

gestion que cada SIG proporciona.
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1.7.2.9. Fuentes secundarias

Son aquellos que se derivan del procesamiento de datos existentes para adaptarlos
a su uso en un SIG. Estos datos provienen de la base que contiene informacion de algin
otro tipo que no se considera como apto para ser usado directamente en un SIG. Un
ejemplo se constituye en la version digital de un mapa tradicional o analdgico.

1.7.3. Analisis multicriterio

Es una herramienta que facilita la evaluacion de multiples soluciones posibles
para un problema especifico. Utiliza una variedad de herramientas y criterios de modo
que logre hacer un proceso simple que sirva para tomar decisiones y alcanzar una solucion
optima. En esencia, este analisis se emplea para examinar y analizar diferentes maneras
de solucion haciendo uso de varios criterios, con la finalidad de determinar la mejor
decision y por ende, la mas apropiada (Valladares, 2022).

1.7.3.1. Ventajas de un analisis multicriterio

De acuerdo con Valladares (2022) presenta las siguientes ventajas:
v Hace simple lo complejo
v Emplea una metodologia en concreto
v Se basa en el empleo de ponderaciones
v" Ejecuta valoraciones intra elementales.
1.7.3.2. Técnicas para realizar el analisis multicriterio
Para Valladares (2022) principalmente existen tres (3) diferentes metodologias
para realizar un andlisis multicriterio, lo cual se describe a continuacion:
1.7.3.3. Boolean Overlay (Superposicion booleana)
Se trata de una operacion de convolucion aplicada a mapas raster binarios, donde

las capas se encuentran representadas mediante valores booleanos: 1 para identificar el
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area de interés y 0 para sefalar el area que no es de interés. El producto resulta es un
nuevo mapa raster en el que el area de interés se refleja mediante el valor 1, cumpliendo
con los criterios previamente establecidos.

1.7.3.3.1. Combinacion lineal directa

Este método evalta de forma cuantitativa y numérica un criterio en vez de aplicar
alguna restriccion booleana. Para esta combinacion cada criterio se denomina “factor” y
emite diferentes niveles de capacidad para tomar una decision. Para implementar esta
técnica, es necesario estandarizar los factores, ya que a veces los criterios pueden estar en
diferentes escalas.
1.7.3.3.2. Fuzzy Overlay (Superposicion difusa)

Esta herramienta hace posible el andlisis de la probabilidad basandose en que un
hecho puede pertenecer a un grupo en especifico; asi como la asociacion de pertenencia
de cada hecho en distintos grupos. Emplea varias técnicas para hacer la determinacion del
sentido de pertenencia hacia diferentes propiedades.

1.7.3.4. Analisis multicriterio en un SIG

Como hemos mencionado previamente, el analisis multicriterio nos brinda la
capacidad de analizar diversas alternativas en la resolucion de un aspecto en especifico,
haciendo uso de diversos criterios y técnicas que facilitan el proceso de tomar decisiones.
En el ambito de los SIG, se utilizan componentes geograficos y espaciales, las cuales
pueden ser de naturaleza discreta o datos continuos. Estas variables geoespaciales abarcan
elementos tales como nucleos urbanos, cursos de agua, topografia, areas de conservacion
natural, superficies forestales, condiciones climaticas, entre otros aspectos relevantes para

el analisis ambiental y espacial (Valladares, 2022).
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CAPITULO II: METODOLOGIA

2.1. Tipo de investigacion
2.1.1. Enfoque

Este analisis es cuantitativo en el sentido que utiliza datos numéricos y da como
resultado la cantidad, ubicacion y extension de zonas Optimas para rellenos sanitarios en
el espacio geografico del distrito de Santa Ana. Son estudios cuantitativos cuando
proporciona datos numéricos y ofrece una alta posibilidad de replicacion y se centra en
puntos especificos de un fenomeno ademas de facilitar comparaciones entre estudios
similares (Hernandez y Mendoza, 2018).

2.1.2. Alcance

El alcance de este estudio es descriptivo, ya que los datos fueron recolectados y
analizados geoespacialmente en el distrito de Santa Ana, tomando en cuenta los aspectos
desarrollados con el objetivo de seleccionar areas de RS. Cuando el objetivo se centra en
medir o recolectar informacidon y reportarla enmarcada en diferentes definiciones u
operacionalizacién relacionada a la fenomenologia que se trata de explicar, se considera
de alcance descriptivo (Hernandez-Sampieri y Mendoza, 2018).

2.1.3. Disefio

Consider6 un disefio no experimental, de corte transversal y por ende, descriptivo,
debido a que los datos fueron recolectados una sola vez y no se manipularon ni
controlaron variables en el espacio geografico del distrito de Santa Ana. En este sentido,
cuando los datos se recolectan una vez para cada categoria, concepto, variable, contexto,
comunidad o fendmeno, y se reporta lo que estos datos revelan, son descriptivos y

transversales (Hernandez y Mendoza, 2018).

Paz Atauchi, G. Pag. 32



UNIVERSIOAD Santa Ana - Cusco, utilizando sistemas de informacion

PRIVADA

1 upN Determinacion de las zonas optimas para relleno sanitaric en el distrito de
DEL NORTE geografica, 2023
2.2. Poblacion y muestra
2.2.1. Poblacion
Se consideré como poblacion al espacio geografico del distrito de Santa Ana,
provincia de La convencion, departamento de Cusco. Con ubicacion geografica:

Longitud: 72°41°36", Latitud: 12°51°46" y Altitud: 1 086 msnm. (INEI, 2022).

2.1.2. Muestra

Este estudio tuvo lugar en la jurisdiccion correspondiente a la geografia del
distrito de Santa Ana.
2.3. Método, técnicas e instrumentos de recoleccion de datos

2.3.1. Método

La metodologia utilizada fue la recoleccion, analisis e interpretacion de datos
geoespaciales del distrito de Santa Ana, teniendo en cuenta los estdndares desarrollados
con el objetivo de seleccionar zonas aptas para relleno sanitario. Un método es descriptivo
cuando implica describir, analizar y explicar sistematicamente un conjunto de variables
(Sanchez y Reyes, 2015).

2.3.2. Técnica

La técnica utilizada en este estudio es la observacion indirecta, ya que utilizamos
datos disponibles en geoportales, obtenidos a través de mediciones en un marco SIG. La
observacion es la técnica de observar o captar sistematicamente los fenomenos que
ocurren en planos reales. Puede ser informacion directa e indirecta, esta ultima requiere
el uso de métodos muy sofisticados. Instrumentos como microscopios, telescopios,

monitores, etc. (Arias, 2016).
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2.3.3. Instrumento

Como herramientas de recoleccion de datos se utilizaron geoportales de
organismos publicos nacionales e internacionales que contienen capas de informacion
geografica de variables fisicas, bioldgicas, socioecondmicas y culturales, y la aplicacion
ArcMap del ArcGIS Desktop, que permiti6 la visualizacion de informacion geografica de
las componentes espaciales y tematicos de capas vectoriales y raster del distrito de Santa
Ana.

2.4. Validez del instrumento

La herramienta para este estudio fueron los lineamientos para la Identificacion de
Areas Potenciales (MINAM, 2021). Entonces no, requiere validacién. También es
importante mencionar que han sido utilizados sobre el mismo tema por diferentes
investigadores descritos en los antecedentes. Para Arias (2016), es obvio que, si el
instrumento fue desarrollado por otro investigador y si fue probado en un estudio previo,
entonces no se debe volver a validar.

2.5. Procedimiento de recoleccion de datos

Por internet se ubicé la Plataforma digital unica del Estado Peruano, donde se
encuentran los geoportales de los diferentes Sectores, seguidamente, se ubico las capas
espaciales teniendo en cuenta las variables para seleccionar el area adecuada.

Posteriormente, se descargd en formato shp y tif las siguientes capas espaciales:
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Tabla 3

Capas espaciales relacionadas a la seleccion de drea para RS

Capas espaciales Formato Datum SC Fuente

Capa vectorial

Punto
Centros poblados shp WGS84 Geogréafico MINEDU
Infraestructura hidrica shp WGS84 Geografico ANA
Granjas avicolas y porcinas shp WGS84 Proyectado SENASA

Linea
Red vial nacional shp WGS84 Geografico MTC
Red vial departamental shp WGS84 Geografico MTC
Red vial vecinal shp WGS84 Geografico MTC
Red hidrografica shp WGS84 Proyectado ANA
Curvas de nivel shp WGS84 Proyectado IGN

Poligono
Limite departamentales shp WGS84 Geografico IGN
Limite provincial shp WGS84 Geografico IGN
Limite distrital shp WGS84 Geografico IGN
Falla geologica shp WGS84 Geografico INGEMMET
Geologia shp WGS84 Proyectado INGEMMET
Catastro minero shp WGS84 Proyectado INGEMMET
Patrimonio arqueoldgico shp WGS84 Geografico MINCUL
Zonif’ica.ci(')n ecologica shp WGS84 Proyectado MINAM
econdmica
Area de conservacion regional shp WGSS84 Geografico SERNANP
Ecosistemas shp WGS84 Proyectado MINAM
Clima shp WGS84 Geografico SENAMHI
Lagunas shp WGS84 Geografico ANA

Capa raster

rsn‘fszepﬁbﬂidad por movimiento en tif WGS84  Proyectado  INGEMMET

Imagen satelital tif WGS84 Proyectado GEOAOR?.II“_IE

Modelo digital de elevacion tif WGS84 Proyectado ASF

Nota. SC = Sistema de coordenadas, shp = Shapefile y tif = Tagged Image File Format.
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2.5.1. Preparacion de los datos espaciales
2.5.1.1. Proyectar una capa a otro sistema de referencia

Se proyecto la capa distrito Santa Ana con coordenadas geograficas a coordenadas
universales transversales de Mercator UTM (WGS 1984 UTM Zone 18S). Paracello, se
utilizd la herramienta Project del ArcGIS a través de la aplicacion ArcMap y con la
siguiente ruta:

ArcToolbox = Data Management Tools > Projections and Transformations > Project

y configuracion segun la Figura 6.

2.5.1.2. Recortes de capas vectoriales y raster

Se realiz6 recortes de las capas vectoriales en base al perimetro del poligono de la
capa distrito de Santa Ana. Para ello, se utilizd la herramienta Clip del ArcGIS a través
de la aplicacion ArcMap y bajo la ruta: y ArcToolbox > Analysis Tools > Extract > Clip
configuracion segun la Figura 7.

También se realizo recortes de las capas raster en base al perimetro del poligono
de la capa distrito de Santa Ana. Para ello, se utiliz6 la herramienta Extract by Mask del
ArcGIS a través de la aplicacion ArcMap mediante la siguiente ruta:

ArcToolbox > Spatial Analyst Tools > Extraction > Extract by Mask 'y  configuracion
segun la Figura 8.
2.5.1.3. Conversion de capa vectorial a raster

Se creo capas raster a partir de puntos de capas vectoriales. Para ello, se utilizo la
herramienta Point To Raster del ArcGIS a través de la aplicacion ArcMap y con la
siguiente ruta:  ArcToolbox > Conversion Tools > To Raster > Point To Raster y
configuracion segun la Figura 9.

Para el caso de polilineas y poligonos con la ruta:
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> Polyline To Raster y Polygon To Raster, 'y configuraciones segin la Figura 10 y
Figura 11.
Figura 6

Proyeccion de capas con sistemas de coordenadas geograficas a UTM

& = LLE 1
5 Seopping-[DBJE | I 5 | ABnTienr+ | Opeosimeblap - Hing~ Stamen Mg« Caald~ MapCusc - Simn-
= e

TTENCIALES Anaisis os] g

Nota. El recurso Project otorga el permiso de emitir un sistema de coordenadas hacia
otro distinto.

Figura 7

Recortes de capas vectoriales segun perimetro del distrito de Santa Ana.

Nota. El recurso Clip otorga el permiso para hacer el recorte de una capa vectorial
basandose en el perimetro de una capa poligonal.
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Figura 8
Recortes de capas raster segun perimetro del distrito de Santa Ana.
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Nota. La herramienta Extract by Mask otorga el permiso para hacer un recorte de parte
de una entidad raster basandose en el perimetro de una capa vectorial.

Figura 9
Conversion de puntos vectoriales a raster.
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Nota. La herramienta Point To Raster permite crear una capa raster a partir de un punto.
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Figura 10
Conversion de polilineas vectoriales a raster.
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Nota. La herramienta Polyline To Raster permite crear una capa raster a partir de una
polilinea.

Figura 11

Conversion de poligonos a raster.
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Nota. La opcion de Polygon To Raster permite generar una capa raster a partir de un
poligono.
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2.5.1.4. Union de capas raster
Se uniod las capas raster de contenidos similares. Con ese objetivo se empled la
opcion de Mosaic To New Raster del ArcGIS a través de la aplicacion ArcMap y con la
ruta: ArcToolbox > Data Management Tools > Raster > Raster Dataset > Mosaic To New Raster
y configuracion segun la Figura 12.

2.5.1.5. Generacion de la distancia euclidiana

Se genero distancias euclidianas de las capas raster. Para ello, se utilizd la
herramienta Euclidean Distance del ArcGIS a través de la aplicacion ArcMap y bajo la
ruta: ArcToolbox > Spatial Analyst Tools > Distance > Euclidean Distance y configuracion segin

la Figura 13.

Figura 12

Union de capas raster.
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Nota. La herramienta Euclidean Distance emite la distancia partiendo de la celda en el
raster hacia el origen mas pronto.
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Generacion de distancia euclidiana.
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Figura 14

Creacion de capas de pendiente del distrito de Santa Ana.
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Nota. La herramienta Slope requiere de un DEM como informacion de entrada.
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2.5.2. Analisis multicriterio con superposicion booleana

Consistid en una operacion de multiplicaciéon de capas en un sistema de
informacion geografica (SIG). A continuacion, se presenta la metodologia de un analisis
multicriterio:

Figura 15

Metodologia de un analisis multicriterio

ler Paso 2do Paso jerPaso 4to Paso 5to Paso
¥ * L3 ¥ ¥
Identificar marco Determinar criterios Determinar algoritmo Andlisis de
Osterminas objetivo de decision (factores y limitantes) o regla de decisién sensibilidad
¥ w
Determinar peso

Estandarizar valores de Factores

Nota. Adaptado de Reyes (2021) citado por Valladares (2022).
En esa linea, se describid los pasos:

Primer paso: determinar objetivo:

En este caso corresponde al objetivo especifico 1:
- Identificar zonas potenciales para el RS en el espacio geografico del distrito de
Santa Ana.

Segundo paso: identificar marco de decisién:

Corresponde al problema especifico 1:
- ¢Qué zonas del espacio geografico del distrito de Santa Ana son potenciales
para relleno sanitario?

Tercer paso: determinar criterio:
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Se definid los criterios para la identificacion de las zonas optimas para RS. Y las
capas se codificaron con los numeros 1 y 0, donde 1 representa las zonas potenciales y 0
las zonas no potenciales. Asi se muestra:
Tabla 4

Estandarizacion de criterios en estructura booleana

Criterios 0 = Zona no potencial 1 = Zona potencial

Restricciones

Distancia a pliegues y

L <500 m > 500 m
fallas geologica
Distancia a cuerpos <500m >500m
de aguas
Distancia a centros <500 m > 500 m
poblados
Distancia a red vial <500 m >500m
D1stanc1’a _a dreas <500 m >500m
arqueologicas
Distancia a arcas de
conservacion <500 m =500 m
regional
Limitantes

Bloques, arena; Bloques, limo; Limolita, pizarra; Pizarra, metarenisca,
Geologia (litologia) Grava, arena; Grava, limo; limolita; Metarenisca, pizarra;
Monzogranito, sienogranito. Metarenisca, pizarra, arenisca.
Muy empinada a Extremadamente

Pendiente de terreno Plana a Empinada (< 50 %)

Vegetacion Secundaria, Bosque
montano de Yunga, Bosque
estacionalmente seco oriental, Bosque
basimontano de Yunga

empinada (> 50 %)

Rio, Laguna, Zonas urbanas,
Ecosistemas Pajonal de puna humeda y Bosque
altimontano (Pluvial) de Yunga

Lluvioso con humedad abundante
todas las estaciones del afio.

Templado. Lluvi . Templad
Clima B (r) B', Semiseco con humedad V1080 con 1n\]§eégl%‘s cco. lemprado.
abundante todas las estaciones del
afio. Templado.
CmB

iq%sjﬁgggstléd:: maggr Muy alto Alto, Medio, Bajo y Muy Bajo

. o . Zonas de recuperacion, Zonas de
Zonificacion Zonas de expansion urbana y teccion de b 7 d
ecologica econdmica Zonas para uso agropecuario proteceion de hosque y ~onas de

proteccion de ladera

Nota. Adaptado de la guia para identificar zonas Optimas para construccion de RS
municipales (MINAM, 2021).
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Cuarto paso: algoritmo o regla de decision:

Se aplico el algoritmo de superposicion booleana con interseccion logica. Para
esto, se automatizo el modelo con la herramienta Model Builder de la aplicacion ArcMap
del ArcGIS Desktop, como se observa en la Figura 17; donde se ejecutd la operacion de
multiplicacion entre capas rasteres reclasificados en binarios, con la ayuda de las
herramientas Raster Calculator y Reclassify. Entendiéndose, cuando los valores de
entrada son diferentes a cero, se tomara como valor de salida al nimero uno. En caso de
que los valores de entrada sean cero, la cifra de salida serd cero; como se muestra a
continuacion:

OutRas = Boolean AND (InRas1, InRas2) (1)

Figura 16

Operacion Booleana AND en capas rdsteres

] value = NoData

InRas1 InRas2 QOutRas

Nota. Adaptado de ESRI.
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Figura 17

Automatizacion del modelo de superposicion booleana con interseccion logica en SIG
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2.5.3. Analisis multicriterio con combinacion lineal directa

Consistié en una operacion de suma de factores estandarizados en diferentes
niveles de aptitud para tomar de decisiones en un SIG. Para ello, se empled la misma
metodologia de analisis multicriterio establecida en la Figura 15:

A continuacidn, se describid los pasos:

Primer paso: determinar objetivo:

En este caso corresponde al objetivo especifico 2:
- Determinar la prelacion segin grado de idoneidad de las areas potenciales para
RS del distrito de Santa Ana.

Segundo paso: identificar marco de decisién:

Corresponde al problema especifico 2:
- /Cudl sera la prelacion segun grado de idoneidad de las zonas potenciales
para RS del distrito de Santa Ana?

Tercer paso: determinar criterio:

Las capas fueron evaluadas como valores continuos en vez de restricciones
booleanas. Para ello, las capas fueron reclasificadas con los valores 1 a 4, donde 1=Malo

0 no aptas, 2=Regular, 3=Aceptable y 4=optimo. Tal como se muestra a continuacion:

Paz Atauchi, G. Pag. 46



UNIVERSIDAD
PRIVADA
DDEL NORTE

Tabla §

Determinacion de las zonas optimas para relleno zanitario en el distrito de
Santa Ana - Cusco, utilizando sistemas de informacion

Estandarizacion de factores en diversos grados de idoneidad

geografica, 2023

Factores 1 = Malo 2 = Regular 3 = Aceptable 4 = Optima
Restricciones
Distancia a cuerpos <500 m 500-750 m 750-1 000 m >1000m
de aguas
Distancia a
pliegues y fallas <500 m 500-750 m 750-1 000 m >1000 m
geologica
Distancia a centros <500m 500-750 m 750-1 000 m >1000m
poblados
Distancia a vias de 500 1 > 000 m 1 500-2 000 m 1.000-1 500 m 500-1 000 m
acceso
Distancia a areas
de  conservacion <500 m 500-2 500 m 2 500-5 000 m >5000m
regional
Distancia 2 areas <500 m 500-2 500 m 2/500-5 000 m >5000m
arqueologicas
Limitantes
Plana a
: Moderadamente
Pendiente de Extremadamente a Muy . o . Fuertemente
terreno empinada (> 50 %) Empinada (25-50 %) Emplnztda (15-25 inclinada (< 15
70) 0
70)
Lluvioso con otoflo e
invierno secos. Frio.
B (0, 1) C'. Lluvioso con
humedad abundante
todas las estaciones del . . Lluvioso con
~ Lluvioso con Lluvioso con -
. afio. Templado. o o invierno seco.
Clima B (r) B. Semiseco con invierno seco. invierno seco. Templado. B (i)
humedad abundante Templado. B (i) B Templado. B (i) B B
todas las estaciones del
afio. Templado.
C@mB
Rio, Laguna, Zonas Bosque
urbanas, Bosque estacionalmente seco L
. . . . Bosque montano de Vegetacion
Ecosistemas altimontano (Pluvial) de oriental, Bosque .
. . Yunga Secundaria
Yunga y Pajonal de basimontano de
puna humeda Yunga
Bloques, arena;
, Bloques, limo; Grava, Metarenisca, pizarra; Pizarra,
Geologia - L . . . L .
. , arena; Grava, limo; Metarenisca, pizarra, metarenisca, Limolita, pizarra
(litologia) . . oo
Monzogranito, arenisca. limolita
sienogranito.
Susceptibilidad por
movimiento en Muy alto Alto Medio Bajo
masa
Zonificacion Zonas de expansion - Zonas de proteccion
. Zonas de proteccion Zonas de
ecologica urbana y Zonas para uso de laderas -
all . de bosque - recuperacion
econdmica agropecuario montafiosas

Nota. Adaptado de Guia para la identificacién de zonas potenciales para infraestructura
de disposicion final de residuos so6lidos municipales (MINAM, 2021).
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Cuarto paso: algoritmo o regla de decision:

Se aplico el algoritmo de combinacion lineal directa con intersecciones logicas.
Para esto, se automatizo el modelo con la herramienta Model Builder de la aplicacion
ArcMap del ArcGIS Desktop, como se encuentra en la Figura 18; donde se ejecut6 la
operacion de suma entre valores rasteres reclasificados en variables continuas, con la

ayuda de las herramientas Raster Calculator y Reclassify. A continuacion, se detalla:

S = ZXl- 2)

Donde; S es idoneidad, X es el valor del factor 1.

2.5.4. Zonas optimas para relleno sanitario

Se realizd la seleccion por atributos (zonas optimas), de la capa resultado del
modelo de combinacion lineal directa. Para ello, se utilizo la herramienta Select Layer
By Attribute del ArcGIS a través de la aplicacion ArcMap y con la siguiente ruta:
ArcToolbox > Data Management Tools > Layer and Table Views > Select Layer By Attribute.

Seguidamente se cred una capa de zonas Optimas para relleno sanitario con la
herramienta Feature Class to Feature Class del ArcGIS a través de la aplicacion ArcMap
y con la siguiente ruta: ArcToolbox > Conversion Tools > To Geodatabase > Feature Class to

Feature Class.
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Figura 18

Automatizacion del modelo de combinacion lineal directa con interseccion logica en SIG
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2.6. Procedimiento de tratamiento y analisis de datos

El procedimiento de tratamiento y andlisis de datos para este estudio se inicia con
la recopilacion meticulosa de datos topograficos, cartograficos y demograficos de la zona
de estudio. La creacion de una base de datos SIG implica la digitalizacion y
georreferenciacion de mapas, integrando informacion demogréfica y geofisica clave.
Posteriormente, se realiza un preprocesamiento de datos para limpiar y validar la base,
normalizando variables para garantizar la coherencia en el andlisis.

El andlisis multicriterio se lleva a cabo, identificando criterios relevantes y
asignandoles pesos segin su importancia. Se aplican técnicas de superposicion espacial
y combinacion lineal para generar un indice de idoneidad. La verificacion en campo
valida los resultados mediante visitas directas, corrigiendo posibles desviaciones entre los
datos tedricos y la realidad. La generacion de mapas tematicos proporciona
visualizaciones claras de las zonas 6ptimas para el relleno sanitario, incluyendo detalles
sobre variables significativas. A través de analisis estadistico descriptivo, se examinan
medidas de tendencia central y dispersion para obtener una comprension mas profunda
de los datos.

La presentacion de resultados se realiza mediante informes detallados y
visualizaciones efectivas, preparando material grafico para presentaciones y divulgacion.
Este procedimiento exhaustivo asegura una investigacion soélida y confiable,
proporcionando una vision integral sobre las dreas mas adecuadas para la construccion de
un relleno sanitario en el Distrito de Santa Ana - Cusco, utilizando sistemas de

informacion geografica
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2.7. Aspectos éticos de la investigacion

La metodologia empleada en la investigacion no atenta con el bienestar publico
ni con ningun componente ambiental debido a que todas las bases de datos son extraidas
a través de plataformas online. Este estudio busca enfatizar la importancia de algunos
aspectos concretos del desarrollo socioambiental. Dado que estd estrechamente
relacionado con la ética en la investigacion, porque su propdsito es beneficiar a la
sociedad y dar a conocer el potencial de este. Para comprender el significado de este tipo
de investigacion, se agregan puntos de vista adicionales. La consulta, por otro lado, se

realizo utilizando diversas fuentes bibliograficas, todas correctamente citadas y

referenciadas utilizando el formato APA como se describe en su séptima edicion.
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CAPITULO III: RESULTADOS

3.1.0bjetivo especifico 1:

“Determinar las zonas en el espacio geografico del distrito de Santa Ana que son
potenciales para la ubicacion de un RS”, a partir del cual se exponen los resultados a
continuacion:

La aplicacion del modelo de superposicion booleana con interseccion logica en
analisis multicriterio con SIG permiti6 conocer la cantidad, ubicacion y extension de las
areas potenciales para RS en el espacio geografico del distrito de Santa Ana. A
continuacion, se detalla:

Tabla 6

Identificacion de zonas potenciales para relleno sanitario

Zona potencial (ZP) Este (m) Norte (m) Extension (ha)
ZP 1 753073.33 8587725.58 11.49
ZP 2 757826.92 8584110.73 6.78
ZP 3 756634.23 8580626.43 14.07
ZP 4 748242.20 8571701.45 9.18
ZP 5 742124.22 8570602.34 15.81
ZP 6 738814.60 8571132.77 6.96
ZP 7 736154.97 8572863.32 5.12
ZP 8 740224.39 8573979.51 9.60

Minimo 5.12
Maximo 15.81
Total 79.00

Nota. La ubicacion en coordenadas UTM corresponde al centroide de cada poligono.

En cuanto al area de las zonas potenciales, es importante precisar que son mayores

al 4area minima requerida para construir un RS de tipo manual. Tal como se aprecia en la
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Figura 19. En total, suman 79.00 ha, la misma que representa el 0.20% con respecto al

territorio del distrito, como se observa en la
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Tabla 7.
Figura 19

Area minima requerida versus drea potencial

Area minima requerida vs. area potencial

18.00
16.00
14.00
12.00
10.00

8.00

6.00

4.00 I I | , I

SARARRNR

0.00

ZP 1 7P 2 ZP 3 ZP 4 ZP 5 ZP 6 ZP. 7 ZP 8
ID Zona potencial

m Area potencial

Extension (ha)

m Area minima

Nota. Area minima de 5 ha tomada de la Guia para el disefio y construccion de
infraestructuras para disposicion final de desechos solidos (MINAM, 2019).

En la Figura 19 La expresion "Area minima requerida versus area potencial"
sugiere una comparacion entre la cantidad minima de terreno necesaria y la superficie que
se considera como posiblemente apta o disponible para una determinada finalidad, en este
caso, la disposicion final de desechos solidos. En consecuencia, esta comparacion podria
implicar evaluar si las areas potenciales identificadas para la disposicion de desechos

solidos cumplen o exceden el requisito minimo establecido por la guia mencionada
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Tabla 7

Superficie porcentual de zonas potenciales para relleno sanitario

Regla de decision Extension (ha) Porcentaje (%)
Zona potencial 79.00 0.20
Zona no potencial 39101.00 99.80
Total 39 180.00 100.00

La tabla 7 proporciona informacion sobre la distribucion porcentual de las areas
consideradas para un relleno sanitario, dividiéndolas en "Zona Potencial" y "Zona No
Potencial". La "Superficie porcentual de zonas potenciales para relleno sanitario" muestra
que la Zona Potencial abarca 79 hectareas, representando un 0.20% del total, mientras
que la Zona No Potencial tiene una extension de 39,101 hectdreas, constituyendo el
99.80%. La "Regla de decision" establece que, en conjunto, estas dos zonas conforman
la totalidad del area evaluada, que es de 39,180 hectareas, siendo el 100%. En resumen,
la gran mayoria del area examinada se considera no apta para un relleno sanitario, con
solo una pequefia proporcion identificada como potencialmente adecuada.

Con los resultados se elaboré un mapa que ilustra mejor la cantidad, ubicacion y

extension de las zonas potenciales, tal como se observa en la Figura 20.
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Figura 20
Mapa de zonas potenciales para relleno sanitario
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La Figura 20 representa un mapa que visualiza las areas identificadas como potencialmente
aptas para la ubicacion de un relleno sanitario. Este mapa destaca, de manera grafica, las zonas
geograficas que han sido evaluadas y clasificadas como adecuadas para la disposicion de residuos
solidos. La figura proporciona informacion detallada sobre la distribucion espacial de estas zonas
potenciales, ofreciendo una representacion visual que facilita la comprension de la ubicacion y
extension de las areas consideradas para esta finalidad especifica.

3.2.0bjetivo especifico 2:

“Evaluar la prelacion segun grado de idoneidad de las zonas potenciales para RS en el
espacio geografico del distrito de Santa Ana”, a partir del cual se expone:

La aplicacion del modelo de combinacion lineal directa con interseccion ldgica en analisis
multicriterio con SIG permitié determinar la prelacion de las zonas potenciales (ZP) segin grado
de idoneidad, tal como se muestra en la Tabla 8. Cuya distribucion geografica se observa en la
Figura 21.

Tabla 8

Orden de prioridad de zonas potenciales para relleno sanitario

Zona potencial (ZP) Grado de idoneidad Prelacion Extension (ha)
ZP 1 Optima 70 2 11.49
ZP 2 Optima 70 1 6.78
ZP 3 Aceptable ZA 3 14.07
ZP 4 Regular ZR 1 9.18
ZP 5 Regular ZR 2 15.81
ZP 6 Aceptable ZA 1 6.96
ZP 7 Aceptable ZA 2 5.12
ZP 8 Optima 70 3 9.60
Total 79.00

Nota. Para esto se estandarizo los criterios en diversos grados de idoneidad con valores de 1 a 4,
donde 1=Malo o no aptas, 2=Regular, 3=Aceptable y 4=optima, para mayor detalle al respecto
revisar la
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Tabla 5.

La Tabla 8 presenta una clasificacion de las zonas potenciales segun su grado de idoneidad,
su posicion en la prelacion y la extension de cada zona. Las zonas estan etiquetadas como ZP 1,
ZP 2, etc. Cada zona tiene asignado un "Grado de idoneidad" que varia desde "Optima" hasta
"Regular". La "Prelacion" indica su posicion de prioridad, y la "Extension" muestra el tamafio de
cada zona en hectareas. En este contexto, se estandarizaron los criterios de idoneidad en diferentes
grados, utilizando valores de 1 a 4, donde 1 representa "Malo o no aptas", 2 indica "Regular", 3
significa "Aceptable" y 4 denota "Optima". La estandarizacion de los criterios se detalla en la Tabla
5 para proporcionar mayor claridad sobre la asignacion de los grados de idoneidad. En resumen,
la Tabla 8 ofrece una jerarquia de zonas potenciales para relleno sanitario, considerando su
idoneidad, prelacion y extension.

3.3.0bjetivo especifico 3:

“Identificar la informacién geografica en campo de las zonas Optimas para relleno en
campo”, a partir del cual se expone:

Contamos con tres (3) de ocho (8) zonas potenciales, las que fueron clasificadas como
zonas optimas (Z0), tal como se muestra en la Tabla 8. La distribucion geografica se presenta en
un mapa con dos laminas para mejorar la visualizacion diferenciandose segun orientacion al

Noreste (Figura 22) y Suroeste (
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Figura 23).
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Figura 21
Mapa de prelacion segun grado de idoneidad de zonas potenciales para relleno sanitario
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Se utilizé el modelo de combinacidn lineal directa con interseccion ldgica en el andlisis
multicriterio con SIG para establecer la prelacion de las ZP en funcion de su grado de idoneidad.
El resultado de este analisis se presenta en la Tabla 8, donde se clasifican las zonas potenciales
segun su grado de idoneidad, prelacion y extension.

La Figura 21 complementa la tabla proporcionando una representacion grafica de la
distribucion geografica de las zonas potenciales. Este mapa permite visualizar de manera intuitiva
la ubicacion y la prioridad relativa de cada zona en términos de idoneidad para la construccion de
un relleno sanitario. En resumen, la combinacion de la tabla y el mapa proporciona una vision
completa y detallada de la evaluacion de zonas potenciales para el relleno sanitario en funcion de

su grado de idoneidad y prelacion geografica.
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Figura 22
Mapa de zonas optimas para relleno sanitario — Noreste del dist. Santa Ana
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La distribucion geografica de las zonas Optimas para el relleno sanitario en el Distrito de

Santa Ana se presenta de manera detallada en dos mapas separados para mejorar la visualizacion.
La primera lamina, representada por la Figura 22, se centra en la orientacion al Noreste de la zona
en cuestion. Este mapa ofrece una representacion visual especifica de las areas identificadas como
Optimas para la ubicacion del relleno sanitario en la porcién Noreste del distrito. La segmentacion
del mapa por orientacion proporciona una vision mas clara y detallada de las zonas consideradas

ideales para la disposicion de desechos solidos en esa direccion geografica
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Figura 23
Mapa de zonas optimas para relleno sanitario — Suroeste del dist. de Santa Ana
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La distribucion geografica de las zonas Optimas para el relleno sanitario en el
Distrito de Santa Ana se presenta de manera detallada en dos mapas separados para
mejorar la visualizacion. La primera ldmina, representada por la Figura 23, se centra en
la orientacion al Noreste de la zona en cuestion. Este mapa ofrece una representacion
visual especifica de las areas identificadas como Optimas para la ubicacion del relleno
sanitario en la porcion Noreste del distrito. La segmentacion del mapa por orientacion
proporciona una vision mas clara y detallada de las zonas consideradas ideales para la

disposicion de desechos solidos en esa direccion geografica
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CAPITULO IV: DISCUSION Y CONCLUSIONES

4.1. Discusion

En la presente investigacion cuyo objetivo fue determinar las zonas del espacio
geografico del distrito de Santa Ana que son potenciales para relleno sanitario. Se
identificaron areas adecuadas que superan el area minima requerida para un relleno
sanitario manual, abarcando 0.20% del territorio del distrito. Ademas, se evidencia que la
gran mayoria del area evaluada (99.80%) se considera no apta para RS. Estos hallazgos
resaltan la importancia de una cuidadosa seleccion y planificacion de las areas destinadas
a rellenos sanitarios, subrayando la necesidad de enfoques sostenibles y estratégicos en
la gestion de residuos en el distrito de Santa Ana. Frente a ello se puede deducir que se
cumple con el objetivo propuesto y ello se demuestra con los resultados expuestos.
Ademas, se menciona a Bustamante (2022) en su trabajo logr6 obtener ocho (8) zonas
potenciales para relleno sanitario (ZP) en el distrito de Chota, las cuales sumaron 537
hectareas, lo que representa el 2% del area total de 26 645 hectareas. En este estudio
también se obtuvieron ocho (8) areas potenciales para el distrito de Santa Ana. Sin
embargo, estas areas suman 79 hectareas de 39 180 hectareas, o el 0,2%. Esta diferencia
respecto a la superficie se debe principalmente a la naturaleza de las variables analizadas
en cada localizacion, en particular las siguientes: red hidrologica (mayores masas de
agua), geologia (mas fallas y pliegues) y pendiente (muy alto).

Por otro lado, siguiendo con el analisis del primer objetivo, el autor Sierra (2021),
afirmé que sus resultados, consistentes con los nuestros, atafien a condiciones especificas
en el area de investigacion que imponen limitaciones al lugar donde se ubicaran los RS,

como grandes cuerpos de agua y terrenos muy empinados. Asi lo demuestra el trabajo de
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Pérez (2019) y Altamirano (2019), quienes lograron obtener el 0,71% y 0,1% de areas
potenciales para relleno sanitario, respectivamente.

A continuacion, se presenta el siguiente objetivo que buscamos en esta
investigacion: evaluar la prelacion segiin grado de idoneidad de las zonas potenciales para
RS en el espacio geografico del distrito de Santa Ana. A partir de ello, se encontr6 que la
aplicacion del modelo de combinacion lineal directa en analisis multicriterio con SIG
permitié establecer una clasificacion detallada de las zonas potenciales, destacando las
areas con mayor prioridad y grado de idoneidad. Notablemente, las zonas identificadas
como "Aceptables" y "Regulares" ocupan extensiones significativas y poseen posiciones
destacadas en la prelacion, evidenciando una evaluacion meticulosa y estratégica. Este
logro proporciona informacion clave para la toma de decisiones en la gestion de residuos
solidos en el distrito de Santa Ana, destacando las areas prioritarias y su nivel de aptitud
para la disposicion de residuos. Debido a lo expuesto en lineas anteriores, se deduce que
se cumplio con el objetivo propuesto en esta investigacion. Para optimizar el escenario
de toma de decisiones, Altamirano (2019) aplicé el segundo modelo de combinacion
lineal directa en analisis multicriterio SIG y logr6 obtener el area potencial N° 5 (AP_5)
como area O6ptima N° 1 (ZO _1). En esta linea, se pudo determinar las prioridades (1, 2 y
3) segun el grado de idoneidad (regular, aceptable y 6ptima) de las areas potenciales para
RS en el distrito de Santa Ana. Otros autores, como Uscamayta (2021), logrd obtener
como resultado tres (3) areas con potencial medio en la provincia del Cusco. Loyaga
(2019) obtuvo exitosamente dos (2) areas Optimas y trece (13) areas aceptables para RS
en el distrito Las Pirias. A partir de lo expuesto se deduce que existe concordancia entre
los resultados obtenidos en esta investigacion y los de otros autores. Al evaluar la

prelacion segun el grado de idoneidad de las zonas potenciales para relleno sanitario en
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el distrito de Santa Ana, los resultados obtenidos mediante la aplicacion del modelo de
combinacion lineal directa en analisis multicriterio con SIG resaltan areas clasificadas
como "Aceptables" y "Regulares" que ocupan extensiones significativas y tienen
posiciones destacadas en la prelacion.

Finalmente, de acuerdo al ultimo objetivo especifico: Identificar la informacion
geografica en campo de las zonas Optimas para relleno en campo, se halla que la Figura
21 proporciona una representacion grafica detallada de la distribucion geografica de estas
zonas, mostrando de manera intuitiva su ubicacion y prioridad relativa para la
construccion de un relleno sanitario. Ademas, la distribucion geografica se presenta en
dos mapas separados segun la orientacion al Noreste (Figura 22) y Suroeste (Figura 23),
mejorando la visualizacion y ofreciendo detalles especificos de las areas consideradas
ideales para la disposicion de desechos solidos en cada direccion geogréfica. La
combinacion de la tabla y los mapas proporciona una vision completa y detallada de la
evaluacion de zonas Optimas para el relleno sanitario, cumpliendo asi con el objetivo
establecido. Este enfoque metodoldgico robusto y la presentacion visual clara
contribuyen significativamente al éxito del estudio y aportan valiosa informacion para
futuras planificaciones ambientales. Nuestros resultados son respaldados por Sierra
(2021) quien logrd obtener areas potenciales del area Bucaramanga con el siguiente grado
de idoneidad: areas no aptas, areas muy inadecuadas, areas medianamente aptas y areas
aptas, y de acuerdo con su objetivo presento el resultado de seis (6) zonas adecuadas. En
esta linea, Gordillo (2019) logrd obtener ocho (8) areas dptimas para el estado Naranjal.
En este estudio, al igual que Sierra y Godillo, las zonas 6ptimas (ZO) se extrajeron de las
zonas potenciales, las cuales se definieron como: ZO 1 (ZP_2), ZO 2 (ZP 1)y ZO 3

(ZP_8).
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El nimero de areas 6ptimas obtenido en este estudio es mas que suficiente para la
formulacion de proyectos de inversion, ya que s6lo se requieren tres alternativas a la hora
de desarrollar la correspondiente evaluacion econdmica. La extension de estas areas
potenciales representa importantes oportunidades en cuanto a la vida util y al
planteamiento de disefio del plan de obra para disponer los desechos, que puede incluir
plantas de reciclaje y transferencia. Asimismo, se deja claro que los resultados cumplen
con los Lineamientos para el Disefio y Construccion de Infraestructura para la
Disposicion Final de Residuos Solidos Municipales (MINAM, 2019). La priorizacion
basada en la idoneidad de 4reas potenciales representa la optimizacidon de recursos para
futuros estudios como seleccion de areas, geofisicos, impactos ambientales y otros
estudios necesarios para la construccion de un RS. Una posible limitacion de estos
resultados es la precision de los datos espaciales, ya que se trabajé con capas vectoriales
y raster que corresponden a las escalas 1/50 000, 1/100 000 y 1/250 000.

A pesar de la posible limitacion en la precision de los datos espaciales, la
metodologia robusta y la cantidad adecuada de areas Optimas identificadas respaldan la
utilidad de estos hallazgos para la toma de decisiones y el desarrollo de proyectos en

gestion de residuos solidos en el distrito.
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CONCLUSIONES

Respecto al objetivo especifico 1, se identificaron ocho areas potenciales para
relleno sanitario en Santa Ana, con extensiones que van desde 5.12 ha hasta
15.81 ha. A pesar de las limitaciones topograficas, la baja cantidad de areas
potenciales cumple con el requisito minimo de 5 hectareas establecido en los
Lineamientos para el Disefio y Construccion de Infraestructura para la
Disposicion Final de Residuos Solidos Municipales (MINAM, 2019).
Objetivo especifico 2. Se determind la prelacion de las ocho zonas potenciales
para relleno sanitario en Santa Ana, clasificdndolas en zonas Optimas (ZO),
aceptables (ZA) y regulares (ZR). Las zonas optimas fueron ZO 1 (ZP_2),
Z0 2 (ZP_ 1) y ZO 3 (ZP_8); las aceptables fueron ZA 1 (ZP 6), ZA 2
(ZP 2)y ZA 3 (ZP_3);y las regulares fueron ZR 1 (ZP 4)y ZR 2 (ZP_5).
Objetivo especifico 3. Los resultados se presentan en dos mapas separados
segun la orientacion geografica al Noreste (Figura 22) y Suroeste (Figura 23),
mejorando la visualizacion y ofreciendo detalles especificos. La combinacion
de la tabla y los mapas brinda una vision completa y detallada de la evaluacién
de zonas Optimas, cumpliendo con el objetivo establecido. Este enfoque
metodologico robusto y la presentacion visual clara contribuyen al éxito del
estudio y proporcionan valiosa informacion para futuras planificaciones
ambientales.
Objetivo principal. se identificaron tres zonas optimas (ZO) para relleno
sanitario en Santa Ana, siendo ZO 1 (ZP 2), ZO 2 (ZP 1)y ZO 3 (ZP_8).
Estas areas son suficientes para la formulacion de proyectos de inversion en

limpieza publica, al proporcionar tres alternativas viables. Ademas, la
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extension de estas zonas potenciales ofrece oportunidades significativas en
términos de vida util y disefio de la infraestructura para la disposicion final,

incluyendo posiblemente plantas de reciclaje y transferencia.
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CAPITULO V: RECOMENDACIONES

- Objetivo especifico 1. La extension de estas areas potenciales es ventajosa con relacion
al disefio del proyecto respecto a la vida util y a los componentes estructurales de
disposicion final, que puede incluir plantas de reciclaje y transferencia.

- Objetivo especifico 2. Orientar los recursos para la construccion de un RS en el distrito
de Santa Ana, segun orden prioridad o grado de idoneidad de las zonas potenciales.

- Objetivo especifico 3. Utilizar este enfoque metodologico robusto de presentacion
visual clara en futuros estudios y planificaciones ambientales similares.

- Objetivo principal. El planteamiento o disefio del proyecto respecto al método de
disposicion final, debe elaborarse teniendo en cuenta las restricciones de las
pendientes, hidrologia y geologia de la zona. En este sentido, se reduce a los métodos

de area o combinado.
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Tabla 9

Matriz de consistencia

Anexo 1. Matriz de investigacion

para relleno sanitario?

2. (Cudl serda la prelacion
segin grado de idoneidad
de las zonas potenciales
para relleno sanitario en el
espacio  geografico del
distrito de Santa Ana?

Santa Ana.
2. Determinar la prelacion
segin grado de idoneidad
de las zonas potenciales
para relleno sanitario en el
espacio  geografico del

distrito de Santa Ana.

vegetacion secundaria

Zona con clima templado y
himedo

Zona con bajo, medio y alto a
susceptibilidad por movimiento
en masa

Zonas productivas de
recuperacion y proteccion

Zona con area minima > a 5 ha

Problema Objetivo Hipotesis Variable Indicadores Metodologia
Distancia > a 500 m de falla | Tipo investigacion:
geoldgica Investigacion cuantitativa
Distancia > a 500 m de cuerpos
Problema general: Objetivo general: P . .,
, , L. . L. de agua Alcance la investigacion:
(Cual seran las zonas Optimas | Determinar zonas dptimas para : . ., L
S . Distancia > a 500 m de centros | Investigacion descriptiva
para RS en el distrito de Santa | RS en el distrito de Santa Ana -
o o . poblados
Ana — Cusco, utilizando | Cusco, utilizando sistemas de . . e . e,
. . o . , Distancia > a 500 m de la red | Disefio de investigaciéon:
sistemas de informacioén | informacion geografica, 2023. . L .
, vial Diseflo no experimental transversal
geografica, 20237 . . , .
L. B Distancia > a 500 m de areas | descriptivo
Objetivos especificos: L. .,
, Por ser arqueoldgicas Poblacion y muestra:
Problemas especificos: . . ., | Zonas . . , . , .
. investigacion | , . Distancia > a 500 m de areas de | Espacio geografico del dist. Santa Ana
1. Identificar zonas Optimas - .
. . . de alcance conservacion regional
1. (Qué zonas del espacio potenciales para relleno .. para . . , .
, . e .| descriptivo, Zonas con sustrato impermeable | Método, Técnica e instrumento de
geografico del distrito de sanitario en el espacio relleno . .
. , . carece de o Zonas con pendiente < 50 % recoleccion de dato:
Santa Ana son potenciales geografico del distrito de . sanitario . ] ..
hipotesis. Zonas con ecosistemas de | Método: descriptivo

Técnica: observacion indirecta
Instrumento: Geoportales y SIG

Procedimiento de recoleccion de datos:
Geoportales disponibles en linea
Visita a campo

Analisis de datos:
Analisis multicriterio espacial
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Tabla 10

Matriz de operacionalizacion de variable

. . . . . . . . Escala de
Variable unica Definicion conceptual Definicion operacional | Dimensiones Indicadores L
medicion
Son lugares considerados propicios Distancia > a 500 m de falla geologica Razon
para la construccion de un relleno Distancia > a 500 m de cuerpos de agua Razon
sanitario, teniendo en cuenta Criteri Distancia > a 500 m de centros poblados Razén
riterios con - - - -
criterios establecidos (Arias, 2021). restricciones Distancia > a 500 m de la red vial Razon
Determina la  ubicacidon  mads Distancia > a 500 m de areas arqueologicas Razon
conveniente ambientalmente y con Distancia > a 500 m de 4reas de conservacion Razd
L . . azon
Zonas Optimas | mayor rentabilidad para una . regional
L Esta variable se va a - :
para relleno propuesta de obra de relleno sanitario . Zonas con sustrato impermeable Nominal
.. . medir con un SIG - -
sanitario (Javier, 2015). Zonas con pendiente < 50 % Razén
Condiciones Optimas del terreno Zonas con ecosistemas de vegetacion secundaria Nominal
considerando aspectos de tipo fisico, Criterios con Zona con clima templado y humedo Nominal
bioldgico, socioeconomico y limitaciones | Zona con bajo, medio y alto a susceptibilidad por Ordinal
cultural; clasificado en criterios de movimiento en masa a
restricciones y exclusiones Zonas productivas de recuperacion y proteccion Nominal
(MINAM, 2021). Zona con area minima > a 5 ha Razon
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